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Notes on APA Style 
 

Introduction 
What is it? 

APA style is the style of writing that professional psychologists use to write journal 
papers. The guidelines for this style are set out in the Publication Manual of the American 
Psychological Association (2001, 5th ed.). Washington, DC: American Psychological 
Association. The manual covers topics such as (a) what to write in each section of your report, 
(b) writing style and grammar, (c) how to use punctuation and capitalization, (d) how to use 
headings, (e) how to present tables and figures, (f) how to write references. Note that a new 
edition of the manual came out in 2001 (5th edition). 
 
Why do I care? 

You will lose marks if your writing style does not conform to APA style. Writing in the APA 
style will give your report or essay a professional look and will allow the reader to concentrate 
more on what you are saying rather than how you are saying it. 
 
Oh yeah! Exactly how many marks will I lose? 

That depends on what type of APA style errors you make. The APA style covers a wide 
range of stylistic practices, ranging from very basic structural issues (e.g., include an 
Introduction section in your research report) to very specific punctuation use (e.g., use a comma 
to set off the year when using exact dates). The number of marks that you lose as a result of 
deviating from APA style will depend on the type and number of deviations that you make. 
Some APA style errors (e.g., missing out your Introduction section) will result in larger penalties 
than other APA style errors (e.g., missing out a comma). Usually, your marker will make an 
overall assessment of the stylistic component of your work and factor that assessment into the 
final mark that they award. 
 
Why do we have to learn how to write properly? This isn’t an English Language degree, 
it’s a Psychology degree! Isn’t it more important to understand the ideas rather than how 
to put punctuation marks in the right place? 
There are three main reasons why it is important to learn and practice APA style: 
 
1. An idea is only as good as your ability to express it. You may have an excellent 

understanding of the material that is being assessed, but your marker will not be able to 
appreciate this understanding and award you high marks if you express yourself in an 
unclear manner. A key aspect of the APA style is writing in a clear and concise manner. 

 
2. If everyone conforms to the same standardised writing style, then readers can concentrate 

on the content of the research without being distracted by individual differences in writing 
style. The APA style is the agreed writing style for professional psychologists. 

 
3. The University is committed to producing graduates who behave professionally. This notion 

of professionalism includes the ability to report and discuss psychology in a clear and 
concise manner and using a professional style. 

 
Contradictions in Requirements 

Your lecturer or tutor may ask you to ignore one or more of the recommendations made 
in this document and/or in the APA Publication Manual. There will be good educational reasons 
behind such decisions. In this case, you should always follow the requirements set out by your 
lecturer or tutor. 
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Where is it? 

The University has 16 copies of the 5th edition of the APA Publication Manual available. 
Two copies are available in the Auchmuty Information Common, six copies are available in 
Auchmuty Library, three copies are available in the Huxley library, four copies are available in 
the Ourimbah library, and one copy is available in the photocopying room next door to the 
School Office in the Behavioural Sciences Building. Copies are also available in the University 
Campus Bookshop. The cost is $63.00. 
 
How Useful is it? 

Very! I would advise you to buy a copy of this book. You will find it to be an essential 
reference book throughout your studies in psychology. You will find it particularly useful if you 
intend to study at 4th year or if you are a postgraduate student. Note that the book is sometimes 
difficult to navigate. For advice on how to find what you are looking for in the book, please visit: 
http://www.newcastle.edu.au/service/library/info1010/course/apa/apamanual.html 
 
What Other Books are Available? 
APA Companion Books 
Concise rules of APA style. (2005). Washington, DC: American Psychological Association. 
Gelfand, H., & Walker, C. J. (2002). Mastering APA style: Student's workbook and training guide 

(5th ed.). Washington, DC: American Psychological Association. 
Nicol, A. A. M., & Pexman, P. M. (2003). Displaying your findings: A practical guide for creating 

figures, posters, and presentations. Washington, DC: American Psychological 
Association. 

Nicol, A. A. M., & Pexman, P. M. (1999). Presenting your findings: A practical guide for creating 
tables. Washington, DC: American Psychological Association. 

 
Related Books 
Beins, A., & Beins, B. (2008). Effective writing in psychology: Papers, posters, and 

presentations. New York: Blackwell. 
Burton, L. (2007). An interactive approach to writing essays and research reports in psychology 

(2nd ed.). Milton, Australia: Wiley. 
Findlay, B. (2006). How to write psychology research reports and essays (4th ed.). Frenchs 

Forest, Australia: Prentice Hall. 
Houghton, P. M., Houghton, T. J., & Peters, M. F. (2005). APA: The Easy Way!. Port Huron, MI: 

Baker College. 
O'Shea, R. P., Moss, S., & McKenzie, W. (2007). Writing for psychology (5th. ed.). Melbourne: 

Thomson Australia. 
Smyth, T. R. (2004). The principles of writing in psychology. New York: Palgrave Macmillan. 
Taines, C. (2007). A practical guide to writing for psychology. New York: McGraw Hill. 
 
What Websites are Available? 

In order to activate the web links below, please go to Tools > Options > Edit and then make 
sure that the “Use CTRL + Click to follow the hyperlink” box is unchecked. Please note that 
some of the sites listed below refer to the fourth edition of the APA Publication Manual, which is 
similar, but not identical, to the fifth edition. When in doubt, you should always refer to the fifth 
edition. 
 
(1) APA On-Line (2008). Retrieved 18th January 2008 from the American Psychological 

Association: http://www.apastyle.org/index.html 
 
(2) Baker, D., & Henrichsen, L. (17th October 2002). APA reference style: Tightening up your 

citations. Retrieved 18th January 2008 from 
http://linguistics.byu.edu/faculty/henrichsenl/apa/apa01.html 

 

http://www.newcastle.edu.au/service/library/info1010/course/apa/apamanual.html
http://www.apastyle.org/index.html
http://linguistics.byu.edu/faculty/henrichsenl/apa/apa01.html
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(3) Citation styles handbook: APA. (n.d.) Retrieved 18th January 2008 from The Writers' 

Workshop, The Center for Writing Studies, University of Illinois at Urbana-Champaign 
College of Liberal Arts and Sciences: 
http://www.english.uiuc.edu/cws/wworkshop/writer_resources/citation_styles/apa/apa.htm 

 
(4) Degelman, D., & Harris, M. L. (1st August 2007). APA style essentials. Retrieved 18th 

January 2008 from Vanguard University of Southern California: 
http://www.vanguard.edu/faculty/ddegelman/index.aspx?doc_id=796 

 
(5) Dewey, R., Scott, B., & Scribe, D. (Fall 2007). APA research style crib sheet. Retrieved 18th 

January 2008 from Georgia Southern University: http://www.docstyles.com/apacrib.htm 
 
(6) Harnack, A., & Klepinnger, E. (2003). Citation styles on-line: A reference guide to using 

internet sources. Retrieved 18th January 2008 from 
http://www.bedfordstmartins.com/online/cite6.html 

 
(7) Humanities Department. (February 2007). A guide for writing research papers based on 

styles recommended by the American Psychological Association. Retrieved 18th January 
2008 from the Arthur C. Banks Capital Library at Capital Community College: 
http://webster.commnet.edu/apa/ 

 
(8) Learning Support Program. A short guide to author-date referencing (APA style). Retrieved 

18th January 2008 from the University of Newcastle’s Learning Support Program’s 
Blackboard website: https://blackboard.newcastle.edu.au/webapps/login/ 

 
(9) Munro, C. (28th February 2006). Guide to APA style of referencing. Retrieved 18th January 

2008 from The University of Newcastle: 
http://www.newcastle.edu.au/service/library/info1010/apa.html 

 
(10) Munro, C. (27th September 2005). APA citation exercises. Retrieved 18th January 2008 

from The University of Newcastle: 
http://www.newcastle.edu.au/services/library/info1010/ex1.html 

 
(11) Plonsky, M. (21st February 2007). Psychology with style: A hypertext writing guide. 

Retrieved 18th January 2008 from University of Wisconsin - Stevens Point: 
http://www.uwsp.edu/psych/apa4b.htm#intro 

 
(12) Scribe, A. (2007). APA101: APA style research papers. Retrieved 18th January 2008 

from www.docstyles.com: http://www.docstyles.com/apa101.htm 
 
(13) Slater, L., & Sundin-Huard, D. (January 2006). Guide to writing assignments and 

referencing. Retrieved 18th January 2008 from the School of Nursing, University of 
Newcastle, Australia: http://www.newcastle.edu.au/school/nursing-midwifery/docs/writing-
guide.pdf 

 
(14) The Writing Center: APA Documentation. (2006). Retrieved 18th January 2008 from 

University of Wisconsin-Madison Writing Center: 
http://www.wisc.edu/writing/Handbook/DocAPA.html 

 
(15) Williams, O. (5th November 2007). American Psychological Association (APA) format (5th 

edition). Retrieved 18th January 2008 from University of Minnesota, Crookston: 
http://www.crk.umn.edu/library/links/apa5th.htm 

 

http://www.english.uiuc.edu/cws/wworkshop/writer_resources/citation_styles/apa/apa.htm
http://www.vanguard.edu/faculty/ddegelman/index.aspx?doc_id=796
http://www.docstyles.com/apacrib.htm
http://www.bedfordstmartins.com/online/cite6.html
http://webster.commnet.edu/apa/
https://blackboard.newcastle.edu.au/webapps/login/
http://www.newcastle.edu.au/service/library/info1010/apa.html
http://www.newcastle.edu.au/services/library/info1010/ex1.html
http://www.uwsp.edu/psych/apa4b.htm#intro
http://www.docstyles.com/apa101.htm
http://www.newcastle.edu.au/school/nursing-midwifery/docs/writing-guide.pdf
http://www.newcastle.edu.au/school/nursing-midwifery/docs/writing-guide.pdf
http://www.wisc.edu/writing/Handbook/DocAPA.html
http://www.crk.umn.edu/library/links/apa5th.htm


The University of Newcastle, Australia 4
Notes 

Below is a list of general rules from the APA Publication Manual. There are always exceptions 
to these rules and you should consult the Publication Manual to find out what these are. Page 
numbers refer to pages in the Publication Manual. 
 
1. Paper: Type your text on standard-sized white A4 paper. The APA states that you should 

only type on one side of the paper (p. 284). However, according to University regulations, it 
is permissible for you to type on both sides of the paper if you wish. 

 
2. Page numbers: Pages numbers should appear in the upper right-hand corner of the page in 

12 point Times New Roman font (p. 288). In Microsoft Word 2003, Insert > Page Numbers > 
Position: Top of Page (Header). Alignment: Right. Format > Page numbering: Start at “1”. 

 
3. Margins: Leave uniform margins of 1 inch (2.54cm) at the top, bottom, left, and right of every 

page (p. 286). In Microsoft Word 2003, select File > Page Setup and enter the relevant 
values in the Margins fields. 

 
4. Font: Use 12 point Times New Roman font for all text (p. 285). 
 
5. Alignment: Do not justify lines. That is, do not use the word-processing feature that adjusts 

spacing between words to make all the lines the same length (flush with margins). Instead, 
use the flush-left style, and leave the right margin uneven (p. 287). In Microsoft Word 2003, 
select Format > Paragraph and then “Left” from the Alignment dropdown menu. 

 
6. Punctuation spacing: Leave one space, not two, after the full stop (period) at the end of a 

sentence (p. 290). 
 
7. Line spacing: Double-space everything apart from table titles, table headings, figure 

captions, and footnotes, which can be single-spaced (p. 286, p. 326). You may leave an 
additional double-spaced blank line before major subheadings and footnotes and before and 
after tables in the text (p. 326). In Microsoft Word 2003, select Format > Paragraph and then 
“Double” from the Line Spacing dropdown menu. 

 
8. Indicating paragraphs: Do not leave a quadruple-spaced line between paragraphs. Instead, 

leave a double-spaced line as usual and indent the first line of each paragraph by five to 
seven spaces (set tab to ½ inch; p. 289). 

 
9. New pages: Start a new page when you write the (a) Abstract, (b) Introduction, (c) 

References, and (d) Appendices. Do not start a new page when you write the (a) Method, 
(b) Results, or (c) Discussion (pp. 298-299). 

 
10. Headings: APA publication style has five levels of headings (Level 1: Centered upper and 

lower case; Level 2: Centered, italicized, upper and lower case; Level 3: Flush left, italicized, 
upper and lower case; Level 4: Indented, italicized, lowercase paragraph heading ending 
with a period and with the text following on the same line as the heading; Level 5: Centered 
all uppercase). The type of headings that you use will depend on the number of different 
levels of subsection that you require. To work this out, find the section of your paper that 
breaks down into the finest level of subsections and identify how many levels of subsection 
are involved. If you only need one level of heading, then use Level 1. If you need two levels 
of heading, then use Levels 1 and 3. If you need three levels of heading, then use Levels 1, 
3, and 4. If you need four levels of heading, then use Levels 1, 2, 3, and 4. Finally, use all 
five levels if you need five levels of heading. Avoid the following: (a) Having only one section 
in your paper that is headed by a particular level of heading in order to use that level. You 
must have at least two sections in your paper that are headed by the same level of heading 
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in order to use that level of heading (pp. 111-112 & p. 114), (b) Sections that contain only 
one sentence. (c) Sections where paragraphs will suffice. Note that you may leave an 
additional double-spaced blank line before major subheadings (see pp. 111-117.) 

 
11. Full stops: Use a full stop (period) to end a complete sentence. I have seen a lot of people 

ending a sentence with a comma like this, they then go on to begin a new sentence as I 
have just done! Leave one space, not two, after the full stop at the end of a sentence (p. 
290). 

 
12. Commas: There are only six reasons to use a comma in the main text: (1) between elements 

in a series of three or more items (e.g., “Jim liked Tony, Tom, and Dan.”), (2) to set off a 
nonessential or non-restrictive clause, including introductory words or phrases (e.g., 
“However, Jim did not like Roy.”), (3) to separate two independent clauses that are joined by 
a conjunction (“Jim was happy, and Roy was sad.”), (4) to set off the year when using exact 
dates (e.g., “Jim was born on the 9th April, 1943, in Newcastle”), (5) to set off the year in 
parenthetical reference citations (e.g., “Jim had read some recent research on aging 
(Howard, 2005)”, and (6) to separate groups of three digits in most numbers of 1,000 or 
more (e.g., “Jim wanted to live to be 1,050 years old.”; pp. 78-79). 

 
13. Apostrophes: Use an apostrophe to indicate that something possesses something else. As a 

general rule, if the word already ends with an “s” (e.g., two participants) then simply add an 
apostrophe on the end (i.e., two participants’ data). If the word does not end with an “s” 
(e.g., one participant), then add an apostrophe followed by an “s” (i.e., one participant’s 
data). Never use an apostrophe for contractions (e.g., “don’t”, “shouldn’t”, “it’s”). Use the 
unabbreviated phrases instead (i.e., “do not”, “should not”, “it is”). 

 
14. Hyphenation: (a) Do not hyphenate most words formed with prefixes (e.g., “aftereffect”, 

“antisocial”, “midterm”, “nonsignificant”, “posttest”, “subtest”, etc.). An exception to this rule is 
when the prefix ends and the base word begins with the same vowel (e.g., “meta-analysis” 
rather than “metaanalysis”). (b) Hyphenate all ‘self’ compounds (e.g., “self-esteem”), pp. 89-
94. 

 
15. Italics: Use italics, not underlining. Italicize (a) titles of books or journals, (b) the first use of 

new, technical, or key terms, (c) statistical symbols, (d) scale anchors (e.g., “1 = strongly 
disagree”) and (e) journal volume numbers (pp. 100-101). 

 
16. Quotation marks: Use double quotation marks (a) to enclose quotations, (b) to enclose 

material from a test, (c) to enclose verbatim instructions, (d) to enclose the first use of an 
ironic comment, slang, or an invented or coined expression (p. 82). Use single quotation 
marks to indicate a quotation that was enclosed in double quotation marks in the original 
source (p. 119). 

 
17. Capitalization: Capitalize (a) the first letter of the first word of a new sentence, including a 

sentence that follows a colon, (b) the first letters of major words in headings, subheadings, 
and the titles of tables and figures, (c) the first letter of proper names (e.g., “Freud”), (d) the 
first letter of nouns followed by letters or numbers that denote a place in a numbered series 
(e.g., “Experiment 4”, “Condition B”, “Hypothesis 3”), (e) the first letters of major words in 
psychological tests and journal titles (e.g., “Minnesota Multiphasic Personality Inventory”, 
“Journal of Personality and Social Psychology”). NB. Do not capitalize the first letters of 
words for laws, theories, models, or hypotheses (e.g., “social identity theory”, “the self-
esteem hypothesis”), book titles in references (e.g., “Introduction to social psychology”), or 
names of factors, variables or categories (e.g., “neurotic people” and “bipolar depression”; 
pp. 94-100). 
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18. Numbers: As a general rule, use words to express the numbers one to nine but figures to 

express the numbers 10 and above (e.g., “one”, “two”, “three”, “four”, “five”, “six”, “seven”, 
“eight”, “nine”, “10”, “11”, “12”, etc.). Exceptions: (a) Express the numbers one to nine as 
figures if they (i) are grouped for comparison with numbers 10 and above (e.g., “3 of 21 
analyses”, “on 2 trials…but on the remaining 18 trials”), (ii) are numbers that immediately 
precede a unit of measurement or percentage sign (e.g., “a 5-mg dose”, “2 cms”, “3%”), (iii) 
denote a place in a numbered series (e.g., “Experiment 4”, “Hypothesis 3”), or (iv) are 
numbers in the Abstract section, unless they begin a sentence (p. 13, p. 298). (b) Express 
the numbers 10 and above as words if the number begins a sentence, title, or text heading 
(pp. 122-127). 

 
19. Abbreviations and acronyms: (a) Do not use periods with most abbreviations and acronyms 

(e.g., “SIT”, “APA”, “IQ”). (b) To form the plural of an abbreviation simply add “s”, not 
italicised and without any apostrophe (e.g., IQs, Ms, ps, ns). (pp. 110-111). Do not use 
acronyms for terms that are only stated once or repeated infrequently in your text. Do not 
overuse acronyms. As a rule of thumb, you should use no more than three or four acronyms 
in any piece of work. Only use the following Latin abbreviations within parentheses: “e.g.,”, 
“i.e.,”, “vs.”, and “etc.”. Outside parentheses, use the equivalent English translation: “for 
example”, “that is”, “versus”, and “and so forth” (p. 106). 

 
20. Parentheses: (a) Do not use parentheses “( )”to enclose material within other parentheses. 

Use brackets “[ ]” instead: E.g., “We used a popular self-esteem scale (Rosenberg’s Self-
Esteem Scale [RSES])”. (b) Do not use parentheses back-to-back. Use semi-colons instead: 
E.g., Do not say “This has been found in several fields (e.g., industrial, clinical) (Jones & 
Jones, 1975)”. Instead, say “This has been found in several fields (e.g., industrial, clinical; 
Jones & Jones, 1975)”. NB. This rule also applies when making back-to-back citations E.g., 
“(Brown, 1997; Jones, 1972; Smith, 1998)”. (p. 85). 

 
21. Quotations: (a) Use double quotation marks (“…”), not single quotation marks (‘ ’), to enclose 

material that you are quoting from another source and state the page number for that 
source: E.g., Rubin and Hewstone (1998) concluded that “intergroup discrimination leads to 
an increase in self-esteem but is not motivated by a need for self-esteem” (p. 56). NB. "pp." 
means "pages" whereas "p." means "page". Also note that you should leave a space 
between the "p." and the "56". (b) The first letter of the first word in a quotation may be 
changed to an uppercase or a lowercase letter to fit in with the rest of the sentence. Also, 
the punctuation mark at the end of a sentence may be changed to fit the syntax. (c) Use 
three ellipsis points “…” within a sentence to indicate that you have omitted one or more 
words from the original sentence. Use four ellipsis points “….” to indicate that you have 
omitted one or more sentences. E.g., Rubin and Hewstone (1998) concluded that 
“intergroup discrimination…is not motivated by a need for self-esteem” (p. 56). (d) Use 
brackets “[ ]” to enclose material that you wish to add to a quotation. E.g., Rubin and 
Hewstone (1998) concluded that “intergroup discrimination leads to an increase in self-
esteem [consistent with social identity theory] but is not motivated by a need for self-esteem” 
(p. 56). (APA, pp. 117-121). (e) Quotations of 40 or more words should not be enclosed in 
double quotation marks but should instead be typed in a freestanding block of text that is 
indented ½ inch from the left margin (p. 117). 

 
22. Use of “et al.”: If a work has two authors, e.g., “Jones and Smith (1988)”, always cite both 

names. If a work has three, four, or five authors, always cite the full list of authors in the first 
citation you make in your paper. Thereafter, you may use "et al." to refer to the authors that 
come after the first author. E.g., “Smith, Brown, and Jones (1992) compared the pain 
threshold of men and women. Smith et al. found that ….". If a work has six or more authors, 
only cite the first name and then use “et al.”, even on the first citation, pp. 208-209. 

 



The University of Newcastle, Australia 7
23. Use of ampersand: Use "&" inside parentheses but "and" outside parentheses: E.g., “Smith 

and Brown (1998) argued that 20% of women suffer from depression, however, others have 
disagreed (Jones & Jones, 1999).” The exception to this rule is in the reference list, where 
you should always use the ampersand. 

 
24. Use of the term “subjects”: Do not use the term “subjects” to refer to people who consent to 

take part in your research. Instead, use the term “participants”, “individuals”, or 
“respondents”. Reserve the term “subjects” for discussing statistical tests (e.g., “between-
subjects ANOVA”) or animals that have not given direct consent (e.g., infants, rats, pigeons, 
etc; p. 65). 

 
25. Citing multiple studies: Separate a list of citations to studies by different authors using 

semicolons: E.g., “(Brown, 1997; Jones, 1972; Smith, 1998)”. Separate a list of citations of 
studies by the same author using commas: E.g., “(Brown, 1982, 1993, 1998)”. (p. 212) 

 
26. Alphabetize citations and references: Do not list citations or references in chronological 

order. (a) Alphabetize lists of citations in the text: E.g., “(Brown, 1997; Jones, 1972; Smith, 
1998)”, p. 212. (b) Alphabetize the order in which you list references at the end of your 
report (p. 219). You may separate a major citation from other citations within parentheses by 
inserting a phrase, such as “see also” before the first of the remaining citations (p. 212). 

 
27. Citing the same work within a paragraph: Include the year of the citation the first time that 

you make the citation in a paragraph. However, you do not need to include the year in 
subsequent citations of the same work in the same paragraph as long as the study that you 
are citing cannot be confused with other studies that you have cited in your work. E.g., 
“Brown and Smith (1998) found an increase in self-esteem. Brown and Smith concluded that 
this increase was specific to male participants.” (p. 208). 

 
28. Citing from secondary sources: If you are reading from a secondary source, cite the primary 

and secondary source in the text and only cite the secondary source in the reference list at 
the end: E.g., Imagine that you read about Brown's (1987) experiment in Smith's (1992) 
textbook. Here, Brown (1987) is the primary source and Smith (1992) is the secondary 
source. You are getting information about Brown's experiment second-hand from Smith’s 
article. If you want to cite Brown's experiment in your report, then you would say "Brown 
(1987, as cited in Smith, 1992) found that…" and then only list Smith (1992) in the reference 
list at the end of your report. There is no need to list Brown in the reference list (p. 247). 

 
29. Footnotes: Footnotes supplement or amplify substantive information in the text. They should 

not include complicated, irrelevant, or nonessential information. A footnote should convey 
only one idea. You should not include paragraphs in footnotes (p. 202). Type footnotes at 
the bottom of the page on which they are referenced (p. 326). In Microsoft Word 2003, go to 
Insert > Reference > Footnote. The default settings are acceptable (i.e., select the 
“Footnotes” radio button and “Bottom of the Page” from the dropdown menu). 

 
30. Reporting statistical significance: (a) Some statistical software packages (e.g., SPSS) report 

p values to three or four decimal places. In contrast, you should round off to two decimal 
places and report the exact probability (pp. 24-25 & 128-129). For example, if SPSS reports 
a p value of .0392, then you should report this as “p = .04” in your report. Also note that the 
lowest reported significance probability should be p < .01 (pp. 128-129). Hence, for example, 
you should report SPSS p values of both “.0034” and “.0000” as “p < .01” in your report. (b) 
In tables of correlations, identify significant correlations by placing an asterisk “*” after them 
if p < .05 or a double asterisk “**” if p < .01. Include a note under the table explaining the use 
of the asterisks. E.g., “Note. * p < .05, ** p < .01.” (p. 25, pp. 170-171). (c) In tables of 
means, indicate significant differences between values by placing different lowercase 
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subscripts after relevant values (e.g., 13.23a      23.21b) and nonsignificant differences by 
placing the same lowercase subscript after relevant values (e.g., 13.23a      13.22a). Include 
a note under the table explaining the use of the subscripts (e.g., “Means in the same row 
that do not share the same subscripts are significantly different, p < .05”). (p. 171-172). 

 
31. Spacing in statistical text: Include appropriate spaces when reporting the results of statistical 

tests. E.g., “F(1,21)=23.42, p=.04” is difficult to read. Include spaces as follows: “F(1,21) = 
23.42, p = .04” (p. 145). 

 
32. Decimal points: (a) In general, you should round off to two decimal places. Report r, p, t and 

F values to two decimal places. (b) Do not use a zero before a decimal point for correlations 
(e.g., “r = .52”) or levels of statistical significance (e.g., “p = .04”). 

 
33. Tables and figures: (a) Only use horizontal lines in tables. Never use vertical lines (p. 302). 

(b) Titles of tables go above the table (p. 301). Titles of figures go below the figure (pp. 325-
326). 

 
34. Prefer the active voice to the passive voice: The active voice involves making the subject 

active and explicit in the sentence. For example, (1) “The students completed the survey” 
(the students are active) rather than “The survey was completed by the students” (the 
students are passive). (2) “We told participants that…” (the researchers are active and 
explicit) rather than “The participants were told that…” (the researchers passive and implicit). 
(3) “We performed a one sample t-test…” rather than “A one sample t-test was 
performed…”. (4) “Rubin et al. (2004) conducted three experiments rather than “Three 
experiments were conducted by Rubin et al. (2004)” (p. 41-42, 65). 

 
35. Avoid anthropomorphisms: This is when the writer attributes human characteristics, like 

thinking, to inanimate sources, like research reports or statistical tests: E.g., “The present 
research hypothesised that…” Research cannot hypothesize things, only people can 
hypothesize. Rephrase to “I/We hypothesised that…”(pp. 38-39). 

 
36. Personal pronouns: You can use the personal pronouns “I” and “We” in order to avoid (a) 

ambiguity about your own participation as a researcher (pp. 37-38), (b) the passive voice 
(pp. 41-42), and (c) anthropomorphisms (pp. 38-39). The exception is that you cannot use 
personal pronouns in the Abstract (p. 13, p. 14). Here, you must refer to yourself in the third 
person (e.g., “The researchers found that…”). 

 
37. Relative pronouns: The word “that” should only precede clauses that are essential to the 

meaning of the sentence. The word “which” should only precede clauses that are 
nonessential to the meaning of the sentence. Nonessential clauses should be set off with 
commas. E.g., “The questionnaire that was three pages long was handed to the 
participants.” [The structure of this sentence suggests that there were several questionnaires 
that varied in length, and the writer wanted to be specific about which questionnaire was 
given to the participants: the three page questionnaire] “The questionnaire, which was three 
pages long, was handed to the participants.” [The structure of this sentence suggests that 
the information about the length of the questionnaire is not essential information], p. 55. 

 
38. Tense: Use the past tense (a) in the Abstract to describe specific variables manipulated or 

tests applied, (b) in the Introduction (e.g., “Smith showed that…”, “We hypothesised that…”), 
(c) in the Procedure (e.g., “We asked participants to…”), (c) in the Results (e.g., “self-esteem 
increased significantly”), and (e) in the Discussion when describing the results. Use the 
present tense (a) in the Abstract when describing results with continuing applicability or 
conclusions drawn (e.g., “Self-esteem seems to operate as a buffer against anxiety”) and (b) 
in the Discussion to discuss the results and to present conclusions (e.g., “The present 
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research findings indicate that…”; pp. 14, 33, 42). In general, use the present perfect tense 
to express a past action or condition that did not occur at a specific, definite time or to 
describe an action beginning in the past and continuing to the present (e.g., “Several 
researchers have used this method.”; p. 43). 

 
 

References 
You should provide a list of references at the end of your work. The APA Publication Manual 
lists the exact format for referencing journal articles, books, book chapters, newspaper articles, 
webpages, conference talks, abstracts, unpublished works, etc. What follows is a brief summary 
of some key points. For detailed information and examples, please consult the APA Publication 
Manual (pp. 215-281). 
 
General 
1. Only include references in your reference list to works that you have cited in the text of your 

paper (p. 215). 
 
2. Entries should be in hanging indent form (NB. New rule). This means that you should begin 

each entry flush left and indent the second and subsequent lines of the reference (p. 299). In 
Microsoft Word 2003, highlight the text in your reference list, then, Format > Paragraph > 
Select “Hanging” from the Special: dropdown menu. Click OK. 

 
3. List references in alphabetical order by the surname of the first author. If multiple references 

have the same surname, then arrange them alphabetically by the first initial. If multiple 
references have the same surname and initial but different co-authors, then list them 
alphabetically by the surname of the second author or, if the name of the second author is 
the same, by the name of the third or fourth author (and so on). If multiple references have 
the same surname(s) and initials for the author(s), then list them in chronological order by 
year of publication, with the earliest citation first. If multiple references have the same 
surname(s) and initials for the author(s) and the same year of publication, then list 
references alphabetically by the title that follows the date (excluding “A” or “The”). In this 
latter case, lowercase letters – “a”, “b”, “c”, and so on – are placed immediately after the 
publication year within the parentheses in order to distinguish the references in the reference 
list and when they are cited in the text (pp. 219-221). 

 
4. Do not leave blank lines between references. 
 
5. Finish the reference with a full stop (period). 
 
6. With two or more authors, use ampersand (“&”) before the last author and separate with 

commas (p. 224). 
 
 
Journal Articles 
Example 
Brockner, J., & Chen, Y. (1996). The moderating roles of self-esteem and self-construal in 

reaction to a threat to the self: Evidence from the People’s Republic of China and the 
United States. Journal of Personality and Social Psychology, 71, 603-615. 

 
Notes 
1. For titles of articles, capitalize only the first letter of the first word of the title and of the 

subtitle, if any, and any proper nouns (p. 224). 
 
2. Do not use “Vol.” Before the volume number of journals. 
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3. If, and only if, each issue of a journal begins on Page 1, give the issue number in 

parentheses immediately after the volume number (p. 227). 
 
4. Italicize the name of the periodical and the volume number (p. 227). Do not italicise the title 

of the article. 
 
 
Books 
Example 
Coopersmith, S. (1967). The antecedents of self-esteem. San Francisco: Freeman. 
 
Notes 
1. Only capitalize the first letter of the first word of book titles. 
 
2. For the publisher’s location, give the city and state for United States publishers, and city and 

country for publishers outside of the US. NB. See APA p. 217 for locations that can be listed 
without state abbreviations because they are well known for publishing (e.g., New York, San 
Francisco, London, etc) 

 
3. Give the name of the publisher in as brief a form as is intelligible. Write out the names of 

associations, corporations, and university presses, but omit superfluous terms, such as 
“Publishers”, “Co.”, or “Inc.” which are not required to identify the publisher. Retain the words 
“Book” and “Press”. 

 
4. If two or more publisher locations are given, give the location listed first in the book or, if 

specified, the location of the publisher’s home office. 
 
 
Chapters in Edited Books 
(An edited book is one is which different people have written different chapters.) 
Example 
Deschamps, J. -C., & Devos, T. (1998). Regarding the relationship between social identity and 

personal identity. In S. Worchel, J. F. Morales, D. Paez, & J. -C. Deschamps (Eds.), 
Social identity: International perspectives (pp. 1-12). London: Sage. 

 
Notes 
1. Give the names of the authors of the chapter followed by the chapter title followed by a 

period. Then write “In” and give the names of the editors of the book followed by the title of 
the book followed by parenthetical information including the page numbers of the chapter (p. 
229). 

 
2. Because the editors’ names are not in the author position, place the initials before the 

surname (p. 229). 
 
3. Identify the editor(s) with the abbreviation “Ed.” or “Eds.” in parentheses after the surname(s) 

(p. 229). 
 
4. Only the title of the book is italicised. The title of the chapter is not italicised. 
 
 
Material from the Internet 

As a general rule, you should not cite information from general discussion sources on the 
internet (e.g., newsgroups, on-line forums, chat rooms, electronic mailing lists, etc.). These 
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sources do not tend to be peer reviewed and are therefore not regarded as having scholarly 
content (pp. 276-277). If you do have to cite this type of material, then it can be cited as a 
personal communication (see p. 214). 

If you are viewing an electronic article that is an exact duplicate of the printed version, 
then you may simply reference the article in the standard APA manner and add “[Electronic 
version]” after the article title. There is no need to include a retrieval statement. However, if you 
are referencing an online article that is in any way different from the printed version (e.g., no 
page numbers, includes additional data or commentaries), you will need to add the date you 
retrieved the document and the URL (see below). 
 
Examples 
Rubin, M., Hewstone, M., & Voci, A. (2001). Stretching the boundaries: Strategic perceptions of 
intragroup variability [Electronic version]. European Journal of Social Psychology, 31, 413-429. 
 
VandenBos, G., Knapp, S., & Doe, J. (2001). Role of reference elements in the selection of 
resources by psychology undergraduates. Journal of Bibliographic Research, 5, 117-123. 
Retrieved 13th October 2001, from http://jbr.org/articles.html 
 
Borman, W. C., Hanson, M. A., Oppler, S. H., Pulakos, E. D., & White, L. A. (1993). Role of 
early supervisory experience on supervisor performance. Journal of Applied Psychology, 78, 
443-449. Retrieved 23rd October 2000, from PsycARTICLES database. 
 
Electronic reference formats recommended by the American Psychological Association. (12th 
October 2000). Retrieved 23rd October 2000, from http://www.apa.org/journals/webref.html 
 
For further examples, please see the references listed in the “Where Can I Learn More About 
APA Style?” section of this document (p. 2). 
 
 
Notes 
1. Whenever possible, begin the reference with the author(s) name(s) and year of publication. 
 
2. If the author(s) of the document is not identified, begin the reference with the title of the 

document. 
 
3. If the document is not titled, begin the reference with a description of the document. 
 
4. Provide a retrieval statement at the end of the reference. This statement should indicate (a) 

the day, month, and year that the information was retrieved and (b) the internet address (i.e., 
the Uniform Resource Locator or “URL”). 

 
5. Do not place a period or any other character after an internet address. 
 
6. If the internet address is too big to fit on one line, you should break it after a slash or before 

a period. Do not insert a hyphen or any other character at the break. 
 
7. If a document is contained within a large and complex web site (such as that for a university 

or a government agency), identify the host organization and the relevant program or 
department followed by a colon and then provide the internet address. 
 

8. If the information is retrieved from an aggregated database (e.g., PsycARTICLES database), 
then the name of the database is sufficient and no internet address is necessary. 
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This document was prepared by Mark Rubin after consultation with other members of the School of Psychology. 
For further information, please contact Dr Mark Rubin, School of Psychology, The University of Newcastle, 
Callaghan, NSW 2308, Australia. Tel: +61 (0)2 4921 6706. Fax: +61 (0)2 4921 6980. E-mail: 
mark.rubin@newcastle.edu.au 
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